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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

In addition, you can also access the cloud product documentation via https://www.software-
ag.cloud. Navigate to the desired product and then, depending on your solution, go to “Developer
Center”, “User Center” or “Documentation”.

Product Training

You can find helpful product training material on our Learning Portal at https://knowledge.soft-

wareag.com.
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About this Documentation

Tech Community

You can collaborate with Software AG experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:

® Browse through our vast knowledge base.

" Ask questions and find answers in our discussion forums.

Get the latest Software AG news and announcements.

Explore our communities.
® Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://hub.docker.com/publishers/softwareag and discover additional Software AG resources.

Product Support

Support for Software AG products is provided to licensed customers via our Empower Portal at
https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

® Download products, updates and fixes.

® Search the Knowledge Center for technical information and tips.

" Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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Using the Software AG IDL Extractor for PL/I

The EntireX PL/I Wrapper provides access to RPC-based components from PL/I applications. It
enables you to develop both client and server applications. This chapter describes how to use the
IDL Extractor for PL/I.

Extracting Software AG IDL File from Local PL/l Source File

= Start the Wizard
= Select a Source
= Select the File Container

Start the Wizard

Start the IDL Extractor for PL/I Wizard. When the PL/I source file to extract is available in your
workspace and you have selected it, the file location will be entered in the wizard automatically.

6 Software AG IDL Extractor for PL/I



Using the Software AG IDL Extractor for PL/I

Select a wizard
Exkract a new Software &G IDL File from PLIT

YWizards:

|I:~;.f|:|e Filter bext

= Java
= Plug-in Development
== Software AG
E Web Services Stack Packaging Wizard
=-[= Entirex
-ﬂ Entirel Web Service Project
E 101 Extractor For COBOL
EF IDL Extractor for Matural
H] IDL Extrackor For PLJT
P 101 Extractor For WSOL
H! IDL Exkractor For #ML Document
@ IDL Extractor for ¥ML Schema
[ Software AG IDL File
= User Assistance

Select a Source

Select Use local File System or existing RPC Environment, choose File and press Next.

Software AG IDL Extractor for PL/I 7



Using the Software AG IDL Extractor for PL/I

& IDL Extractor for PL/I

Select a Source
The Software 4G IDL File will be extracted from the selected PLIT Source,

This Wizard will help wou ko extract a Software &5 IDL File from a specified PLJT Source, The PLJT
Source can be located in the local File System or can be accessed remotely via a so called RPC
Environment,

{:} Create a new RPC Environment

(*) Use local File System or existing RPC Environment:

|

(= ibmz: 3762 @RPCPLIEXTRACTOR

®

If you selected the PL/I source file before you started the wizard, the file location is already present,
otherwise press Enter or click Browse for the PL/I source file.

& IDL Extractor for PL/I

o
[=0(E3
Select a Source
The Software & I0L file will be extracted from the selected source,

File Mame: | | Browse. ..

Cancel

8 Software AG IDL Extractor for PL/I



Using the Software AG IDL Extractor for PL/I

Select the File Container

Select the Container where the Software AG IDL file will be stored. Enter the File Name of the
new IDL file.

The following rules apply to the Extraction Settings:
® The Source Type must match the PL/I programs you are extracting, otherwise extractions fails.

Adjust the source type in the Preferences; see Preferences.

® For the source type IMS, optionally IMS-specific PCB pointers can be provided in a so-called
PSB List in the field File containing PSB List. See PSB List. The IDL Extractor for PL/I then
marks these parameters with the IMS attribute. See attribute-11st under Software AG IDL
Grammar in the IDL Editor documentation. This is required to create RPC clients correctly calling
IMS BMP programs with PCB pointers successfully.

7= IDL Extractor for PL/I

Select a File Container

The Saftware &5 IDL File will be extracted inka the selected File Cantainer.

Container: *| IPLIE=kractor

File Mame: *| CALC

Extraction Settings

Source Tvpe | EATCH

File containing PSE lisk: |

@ Einish l [ Cancel

Press Finish to extract. For more information see Extraction Result.
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Using the Software AG IDL Extractor for PL/I

Extract Software AG IDL File from a Remote PL/I RPC Environment

This section covers the following topics:

= Start the Wizard

= Select an RPC Environment

= Create RPC Environment (Optional)
= Select Data Set (Optional)

= Select Source and Extract

Start the Wizard

Start the IDL Extractor for PL/I Wizard.

10
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Using the Software AG IDL Extractor for PL/I

- BX]

Select a wizard
Exkract a new Software &G IDL File from PLIT

YWizards:

|I:~;.f|:|e Filter bext

= Java
= Plug-in Development
== Software AG
E Web Services Stack Packaging Wizard
=-[= Entirex
-ﬂ Entirel Web Service Project
E 101 Extractor For COBOL
EF IDL Extractor for Matural
H] IDL Extrackor For PLJT
P 101 Extractor For WSOL
H! IDL Exkractor For #ML Document
@ IDL Extractor for ¥ML Schema
[ Software AG IDL File
= User Assistance

Cancel

Select an RPC Environment

Select Create a new RPC Environment and press Next if no RPC environment exists or you want
to create a new RPC environment. Continue with instructions under Create RPC Environment
(Optional).

Select Use local File System or existing RPC Environment, choose the RPC environment from
the list below and press Next. Continue with instructions under Select Data Set (Optional).

Software AG IDL Extractor for PL/I 11



Using the Software AG IDL Extractor for PL/I

& IDL Extractor for PL/I

Select a Source
The Software &G IDL File will be extracted from the selected PLJT Source,

This Wizard will help wou ko extract a Software &G IDL File from a specified PLJT Source, The PLJT
Source can be located in the local File System or can be accessed remotely via a so called RPC
Environment,

{:} Create a new RPC Environment

(*)Use local File System or existing RPC Environment:

L File
[ ibmZ 3762 @RPCIPLIJEXTRACTOR

Create RPC Environment (Optional)

The connection to the Extractor Service to browse for PL/I programs is defined on the RPC Envir-
onment page. See Extractor Service in the RPC Server documentation for Batch | IMS | BS2000.

In the Broker Parameters, required fields are Broker ID and Server Address, which have the default
format "brokerID@serverAddress". The given Timeout value must be in the range from 1 to 9999
seconds (default: 60).

The EntireX Authentication describes the settings for the Broker, the RPC Server Authentication
the settings for the RPC Server.

The following rules apply to the Extractor Settings:

® A high-level qualifier is required in the Data Set Name or HLQ field. The Extractor Service will
then offer only data sets with this high-level qualifier.

® In the Member Name field you can provide a prefix for the partitioned data set or CA Librarian
members. The Extractor Service will then offer only members beginning with this prefix.

12 Software AG IDL Extractor for PL/I



Using the Software AG IDL Extractor for PL/I

& RPC Environments l B X

New RPC Environment for IDL Extractor for PL/I
Define a new RPC Environment.
Broker Parameters
Broker ID: myhost1971

Server Address: * RPC/PLISRVL/CALLMAT

Timeout (Seconds): &0

EntireX Authentication RPC Server Authentication
User ID: RPC User ID:

Pazzword: RPC Pazzword:

Extractor Settings

Enter names, or use filter for range of values (wildcards * and 7 on any position, < and = as final character only).

Data Set Name: ETS*

Wrapper Settings
(@) Save locally

Save remotely

Environment Mame
@ Default (myhost1971@RPC/PLISRVL/CALLNAT)

@ Other | myhost1971@RPC/PLISRVL/CALLNAT

@ < Back Next > [ Fnish || cancel |

The RPC environments are managed in the Preferences. See RPC Environment Manager for
IDL Extractor for PL/I.

Select Data Set (Optional)

The following page offers all data sets starting with the high-level qualifier defined in the Filter
Settings of the remote PL/I RPC environment. Select the data set from the list and press Next.

Software AG IDL Extractor for PL/I 13



Using the Software AG IDL Extractor for PL/I

& IDL Extractor for PL/I

Select a Source
The Software &G IDL file will be extracted from the selected source.

Datasek;

Mame

EMTIREX.PLI.SERVER. . DFHIR.CE
EMTIREX PLI.SERVER. MWSLCWAD
EMTIREX.PLI. SERVER. MY3SRZE

Takal: 3

Cancel

Select Source and Extract

In the Source pane, select at least one PL/I file from the Member list. The buttons on the right allow
you to Select All or Deselect All members from the list.

The following applies to the Extraction Settings pane:

® The Source Type must match the PL/I programs you are extracting, otherwise extractions fails.
Adjust the source type in the Preferences; see Preferences.

® For the source type IMS, optionally IMS-specific PCB pointers can be provided in a so-called
PSB List in the field File containing PSB List. See PSB List. The IDL Extractor for PL/I then
marks these parameters with the IMS attribute. See attribute-11ist under Software AG IDL
Grammar in the IDL Editor documentation. This is required to create RPC clients correctly calling
IMS BMP programs with PCB pointers successfully.

® In the Target (Eclipse Workspace) pane, select the Container where the IDL file will be stored.
Enter the name of the new IDL file.

14 Software AG IDL Extractor for PL/I



Using the Software AG IDL Extractor for PL/I

7= IDL Extractor for PL/I

Select a Source

The Software &G IDL File will be extracted From the selected source,

Source (PLIT)
List of members Fram daka set EMTIREX,QE.PLL, SRCE:

Il g

Mame Created Modified Records Select all
CALC 2004-09-16 2004-09-16 15:23 44
[] cops#ru 2005-11-21 2005-12-05 16:59 18 | (Deselect Al
[] DEFALLT
EXAMPLE 2005-11-17 2005-11-21 12:15 26
D EXLIP#L 2005-01-16 2006-01-16 13:26 o5
[] Exup#z 2006-01-16 2006-01-16 14:04 Kt K
'_I Lt TN I ¥ "L} St el 47 ialnintalal 47 4 dams A4 —_—
Tokal: 122
Extraction Setkings
Source Type | BATCH
File containing PSE lisk: | | Browse, ..

Target (Eclipse Warkspace)

Conkainer: | \PLIE=tractar | |Eir|:|ﬂse...

File Mame: | ENTIREX.QE.PLI, SRCE |

[]save selected sources locally on Finish

® Mext = [ Einish H Zancel

Press Finish to extract. For more information see Extraction Result.

Software AG IDL Extractor for PL/I 15



Using the Software AG IDL Extractor for PL/I

Extraction Result

When the operation is completed, the IDL file is opened with the IDL Editor.

If the PL/I source contains IMS-specific PCB Pointers as described in the RPC Server for IMS docu-
mentation, the extracted IDL contains those pointers marked with the attribute "IMS". See attrib-
ute-1ist under Software AG IDL Grammar in the IDL Editor documentation. As a preceding step,
use the PL/I Wrapper to generate server interface object(s) and provide them to the RPC Server
tfor IMS. See Using the PL/I Wrapper for IMS BMP.

If the PL/I source file contains parameters that cannot be mapped to IDL parameters, an IDL file
with incorrect IDL syntax is created. The unsupported parameters lead to IDL parameters of data
type "Error", which is not supported. The Problems View of the PL/I source file contains markers
for all unsupported parameters.

Preferences

The preference page for IDL Extractor for PL/I manages the default values for the IDL Extractor
for PL/I Wizard.

The following applies to the Extraction Settings pane:

® The Source Type must match the PL/I programs you are extracting, otherwise extractions fails.
Adjust the source type in the Preferences.

® For the source type IMS, optionally IMS-specific PCB pointers can be provided in a so-called
PSB List in the field File containing PSB List. See PSB List. The IDL Extractor for PL/I then
marks these parameters with the IMS attribute. See attribute-1ist under Software AG IDL
Grammar in the IDL Editor documentation. This is required to create RPC clients correctly calling
IMS BMP programs with PCB pointers successfully.

16 Software AG IDL Extractor for PL/I



Using the Software AG IDL Extractor for PL/I
F Bl
Preferences E@g
type filter test IDL Extractor for PL/I =1 v
a EntireX - .
COBOL The PL/I preferences are used to extract IDL Files from PL/I source.
>
Integration Servers EimE T SFilg=
» Matural Source Type: BATCH -
o File containing PSB list Br
IDL Extractor for PL/I |?| ile containing ist: IOWSE...
PLI Wrapper i The PL/TIRPC environments are managed on the Preferences page 'RPC Environments for [DL Extractor for PL/T
9 pag
RPC Envirenments for !
> Web Services
> Wrappers
a| L "“'r'r'[“' Tool - [Restore D‘efaultsl ’ Apply
® [ oK ] [ Cancel
e
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3 Using the IDL Extractor for PL/l in Command-line Mode

= Command-line Options

= Example ...vviiinnnns
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Using the IDL Extractor for PL/I in Command-line Mode

Command-line Options

See Using EntireX in the Designer Command-line Mode for the general command-line syntax.

Task Command Option Description
Extract the PL/I source|-extract:pli|-brokerpassword|Password used for broker authentication.
objects from an -brokeruser User used for broker authentication.

RPC Extractor Service.

-environment

Name of the environment or an RPC server
description.

-filter Filter the PL/I source objects. Show those
objects which match the pattern.
-help Display this usage message.
-ims Name of the file with the names of the IMS
PSB parameters.
-project Name of the project or subfolder where the
IDL file is stored.
-rpcpassword Password used for RPC server authentication.
-rpcuser User used for RPC server authentication.
-source A PL/I source object in the environment.
List the PL/I source -Tist:pli -brokerpassword|Password used for broker authentication.
objects on an RPC -brokeruser User used for broker authentication.

Extractor Service.

-environment

Name of the environment or an RPC server
description.

-filter Filter the PL/I source objects. Show those
objects which match the pattern.

-help Display this usage message.

-rpcpassword Password used for RPC server authentication.

-rpcuser User used for RPC server authentication.

-source A PL/I source object in the environment.

20
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Using the IDL Extractor for PL/l in Command-line Mode

Example

<workbench> -extract:pli -environment pliBroker:2006@RPC/PLISRVI/EXTRACTOR -project «
/Demo -source PLI.DATA.SET -filter PLISRCI

where <workbench> is a placeholder for the actual EntireX design-time starter as described under
Using EntireX in the Designer Command-line Mode.

The extracted Software AG IDL file will be stored in the project Demo.

If the environment name is not a defined RPC environment in the current workspace, the name
will be interpreted as a Broker ID and RPC server address (brokerID@serverAddress).

The source specifies a data set name, and the optional filter defines the member name. Simple
wildcard notation with an asterisk (*) can be used at the end of these names.

Status and processing messages are written to standard output (stdout), which is normally set to
the executing shell window.

Software AG IDL Extractor for PL/I 21
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4 PL/I to IDL Mapping
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PL/I to IDL Mapping

This chapter describes how PL/I data types, their attributes and related syntax are mapped to
Software AG IDL data types by the IDL Extractor for PL/I.

IDL Extractor for PL/l Input

PL/I'source code is the input for IDL generation. The IDL Extractor for PL/I inspects the parameter
definition of PL/I procedures or PL/I functions and their DECLARE statements.

The sources

" must contain external PL/I procedures or PL/I functions;
" must be free of preprocessor statements;

® must be compiled with no errors and no warnings.

IDL Extractor for PL/l Output

The IDL Extractor for PL/I generates:

* the Software AG IDL file name by adding the extension “.idl” to the PL/I source file name without
extension;

® the Software AG IDL library name from the PL/I source file name without extension;

= the Software AG IDL program name from the name of the PL/I external procedure or function.

Mapping PL/I Data Types to Software AG IDL

The IDL generator maps the following subset of PL/I data types to IDL data types, other PL/I data
types as transfer parameters are not supported. If the PL/I source file contains parameters which
cannot be mapped to IDL parameters, an IDL file with incorrect IDL syntax will be created.

The following metasymbols and informal terms are used for the Software AG IDL in the table
below.

® The metasymbols "[" and "]"enclose optional lexical entities.

® The metasymbols "(" and ")" enclose numeric expressions which must be evaluated.

* The informal term n and m is a sequence of numeric characters, for example 123.

The metasymbols "*" and "/" represent a numeric expression which must be evaluated for the
real number.

24 Software AG IDL Extractor for PL/I



PL/I to IDL Mapping

PL/I Data Type Software AG IDL | Description Notes
CHARACTER (m) An Alphanumeric 1
CHARACTER (*) AV Alphanumeric variable length

CHARACTER (n) VARYING|AVn Alphanumeric variable length with maximum length |1
GRAPHIC (n) K(n*2) Kanji fixed length 2
GRAPHIC (*) KV Kanji variable length

GRAPHIC (n) VARYING |KV(n*2) Kanji variable length with maximum length 2
BIT (n) B(n/8) Binary 3
BIT (*) BV Binary variable length

FLOAT BINARY Fa4 Floating point (small)

FLOAT BINARY (21)

FLOAT DECIMAL

FLOAT DECIMAL(6)

FLOAT BINARY (53) F8 Floating point (large)

FLOAT DECIMAL (16)

FIXED BINARY I1 Integer (small)

FIXED BINARY (7)

FIXED BINARY (15) 12 Integer (medium)

FIXED BINARY (31) I4 Integer (large)

BIT L Logical

BIT (1)

PIC 'SCmILV(mMI9l’ NmC.n] Unpacked decimal

PIC "(mILV(mMI91" NUmL . n] Unpacked decimal unsigned

FIXED DECIMAL (m,n) |[P(m-n)[.n] |Packed decimal 5

| Notes:

1. nis the number of graphic characters (DBCS).

2. nis the number of DBCS characters.

3. nis the number of bits and n must be a multiple of 8.
4. m,n, are numbers, where n <=7, n<=29 and m+n <=29.
5. m,n, are numbers, where n <=7 and m <= 209.

Software AG IDL Extractor for PL/I 25



PL/I to IDL Mapping

Functions

The function return value of a PL/I external function will be mapped to an additional parameter
“Function_Result” with the direction out; this parameter will be appended to the last parameter
of the procedure.

For example, the external function R_CHAR

R_CHAR: PROCEDURE (p) RETURNS ( CHAR (20) )
PUT SKIP LIST('R_CHAR $dollar;:Revision: n.n $');
DCL p CHAR(10);
RETURN (p);

END R_CHAR;

This will be mapped to the Software AG IDL program:

program 'R_FLOAT" is
define data parameter
1p (F4) In Out
1 Function_Result (F4) OQut
end-define

Structures

Structures are mapped to Software AG IDL groups. Asterisks as fillers or reserved items are not
supported.

declare 1 Payroll,

2 Name,
3 Last char(20),
3 First char(15),
2 Hours,
3 Regular fixed dec(5,2),
3 Overtime fixed dec(5,2),
2 Rate,

3 Regular fixed dec(3,2),
3 Overtime fixed dec(3,2);

This example will be mapped to the following Software AG IDL:
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PL/I to IDL Mapping

1 Payroll In Qut

2 Name
3 Last (A20)
3 First (A15)

2 Hours
3 Regular (P3.2)
3 Overtime (P3.2)

2 Rate
3 Regular (P1.2)
3 Overtime (P1.2)

Arrays

Arrays are mapped to Software AG IDL arrays. The dimension of an array is restricted to 3.

DCL A CHAR(10) DIMENSION (100);

DCL B CHAR(C10) DIMENSION (*);

DCL C CHAR(10) DIMENSION (-5:10);
DCL D CHAR(C10) DIMENSION (10,10,10);

This example will be mapped to:

1 A (A10/100) In Out
1 B (AIO/V) In Out
1 C (AL0/16) In Out
1 D (A10/10,10,10) In Qut
Aligned

The ALIGNED attribute will be mapped to the Software AG IDL attribute aligned. See attribute-
11st under Software AG IDL Grammar in the IDL Editor documentation.

PL/I to IDL Restrictions

The following table lists features, clauses and items that are not supported by the IDL Extractor
for PL/I:

Software AG IDL Extractor for PL/I 27



PL/I to IDL Mapping

ltem

Description

PL/I Preprocessor

MACRO preprocessor for PL/I source program alteration. It is executed prior to
compilation

UNALIGNED attribute

The UNALIGNED attribute reduces to one byte the alignment requirements for
halfwords, fullwords, and doublewords and it reduces to one bit the alignment
requirement for bit strings.

28
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5 RPC Environment Manager for IDL Extractor for PLI/I

The RPC environment for IDL Extractor for PL/I is managed on the Preferences page.
Use the RPC Environment Monitor to check the availability of each RPC environment.

Using this wizard, you can add new RPC environments for IDL Extractor for PL/I. To manage
these RPC environments, open the Preferences page.

Al

= Preferences .. |_ & e

4

type filter text RPC Environments for IDL Extractor for PL/I =1 v
4 Software AG -
Ajax Developer

API-Portal Table of defined RPC envirenments:

Business Services MName Broker ID Server Address : Insert...

Manage the RPC Environments for IDL Extractor for PL/L

7

7

Code Generation
Construct PI.ISR‘M"l localhost:1971 RPC/PLISRVL/CALLNAT

v

=

Edit...

Document Expansion — :

4 Entirex Duplicate
» COBOL

Integration Servers

m

Remave

Tl

> Matural
4 PLI [
DL Extractor for PL/I
PL/TWrapper
RPC Environments for IDL Extractor for PL/T
> Web Services
> Wrappers

® [ OK ] [ Cancel

~ To edit an existing RPC environment

m  Select the table row and press Edit.... If multiple entries are selected, the first entry is used.
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> To remove an RPC environment

m  Slect the table row and press Remove. You can select multiple environments.

> To create a new RPC environment

1 Choose Insert... to call the following screen:

-

& RPC Envircnments

Define a new RPC Environment.

Broker Parameters

Broker I: localhost:1971

Server Address: * RPC/PLISRVL/CALLNAT

Timeout (Seconds): 60

EntireX Authentication
User ID:

Password:

Extractor Settings

Data Set Name:

Wrapper Settings
(@ Save locally

Save remotely

Environment Mame
() Default

Mew RPC Environment for IDL Extractor for PL/I

RPC Server Authentication
RPC User ID:

RPC Password:

Enter names, or use filter for range of values (wildcards * and 7 on any position, < and = as final character only).

@ Other  PLISRY]|

< Back

Next > | Finsh || Cancel
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RPC Environment Manager for IDL Extractor for PL/I

2 Enter the required fields: Broker ID, Server Address and a unique Environment Name, which
will have the default format brokerID@serverAddress. The given Timeout value must be in the
range from 1 to 9999 seconds (default: 60).

EntireX Authentication describes the settings for the broker, and RPC Server Authentication
describes the settings for the RPC server.

Use Extraction Settings to specify the name of the Data Set/Library and the Member/Program
name.
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6 RPC Environment Monitor

The RPC Environment Monitor is part of the Software AG Designer. It is an Eclipse view that
provides a quick overview of the availability of the defined RPC environments in your workspace.

~ To open the RPC Environment Monitor from the EntireX perspective

s Choose Window > Show View > RPC Environment Monitor.

~ To open the RPC Environment Monitor from a non-EntireX perspective

s Choose Window > Show View > Other > Software AG > RPC Environment Monitor.

The RPC environments are managed on the Preferences page. See RPC Environment Manager
for IDL Extractor for PL/I.

RPiC Enwiranment Monitar &2 2]

Table of defined RPC environments:

MName Broker ID Server Address Skatus
7 Java RPC Server @ localhost: 1971 @ RPC/SRY1JCALLMNAT Broker Error 0007 0007; RPC/SRYLMCALLMAT not registered
-_'3” Matural RPC Server @ localhost: 1971 B RPC/MATSRWZEO0MCALLMAT - Matural RPC Server 6.3.4.4 on WHNT-2386 (NATAS11.0)
E’ﬂ #MLISCAP RPC Server B localhost: 1971 @ RPOSRMUSERVER/CALLMAT  Enkired #ML RPC Server 8.2.2.0,162 Windows 2P 5.1 %86,

The status check starts when the view is opened. To force an additional check, choose Refresh
from the Views toolbar. The status check can be cancelled in the dialog that appears or within the
Eclipse progress view. When the check is complete or if it cancelled, the following symbols indicate
the status of the corresponding item. The table will be reloaded every time a status check is started
to make sure all stored RPC environments are available.
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Symbol | Status

| Running.
e Not running.
E4AN

Unknown (at the beginning of the check or if the check was cancelled).

| Note: Additional status information (including error messages) is displayed when refreshing
the view (by a ping command to all specified RPC servers).
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